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All Users: 

DaqView can only be used with one device at a time. 

For use with multiple DaqBoard/2000 Series or DaqBook/2000 Series 
devices, via custom programming, refer to the Programmer’s Manual 
(1008-0901), chapter 3, Using Multiple Devices. 

 

 

 

 

 

 

 
TempBook Users: 

TempBook devices do not make use of DBK cards or DBK modules, nor do 
they make use of certain DaqView functions.  TempBook users should skip 
over material that is identified as “not applicable to TempBook.”    
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Overview 
DaqView is a 32-bit Windows-based data acquisition program that can be used to operate DaqBook/2000 
Series devices, DaqBoard/2000 Series boards, ISA-type DaqBoards, DaqBook/100/200 Series devices, Daq 
PC-Cards, and TempBooks.    
 
Daq devices typically make use of optional DBK cards and modules.   TempBooks are never used with 
DBK cards or modules. 
 
Note:  TempBook does not make use of optional DBK cards or DBK modules. 
 
DaqView was designed for ease-of-use; programming expertise is not required.  DaqView allows you to: 

• Set up system parameters (selecting channels, gains, transducer types, etc) to acquire data. 
• Save data to disk and transmit data to spreadsheets and databases. 
• Automatically re-arm the trigger function and save data in new files as needed. 
• Configure and operate the DBK option modules. Does not apply to TempBook. 
• Configure the counter/timer into one of three modes for measuring frequency, totalizing, or 

generating pulse trains. Does not apply to TempBook. 
• Use analog outputs, including waveform generation, for DaqBoard/2000, /2001, /2003, /2004, 

DaqBoard/2000c, /2001c, /2003c, /2004c, and DaqBook/2000 Series devices, providing that the later 
have a DBK46 option installed.  Does not apply to TempBook. 

• Use digital I/O (for Daq devices with digital I/O). Does not apply to TempBook. 

A Post Acquisition Data Analysis Program, if installed, can be launched from DaqView to view, 
measure, and edit data.  eZ-PostView is an example of a post data acquisition analysis program. 

DaqViewXL is a Microsoft Excel-based “add-in.” The application is discussed in a separate document 
module that is included as part of this manual. 

Starting DaqView 
Minimum computer requirements include: 

• IntelTM Pentium® P100, or equivalent  
• 32 Mbytes of RAM 
• Windows 95/98, Windows NT 3.51, Windows NT 4.0, Windows 2000, Windows XP, Windows Me. 
• Data acquisition hardware 

To run DaqView, double-click the DaqView icon or use your Windows desktop Start button to navigate to 
the program file. 
Note: If acquisition hardware is not available, or you just want to explore the software, you can select 
Simulated Instrument; the main window will open (see following figure). 
When DaqView detects hardware, or a simulated instrument has been selected, DaqView’s main window 
will open. 

Note:   In event of a Daq device communication problem, exit DaqView and perform a hardware test from 
the Daq Configuration applet control panel.  

The following figure shows DaqView’s main window for a DaqBoard/2000.  The table identifies the toolbar 
buttons, and other buttons that are visible when the Channel Setup Tab is selected [as in the following 
figure].   

A Tour of DaqView 
This section includes a look at DaqView’s main window, a discussion of functionality for DaqBoard/2000 
Series, DaqBook/2000 Series, and TempBook, and steps for completing a self-tour of DaqView.  The tour 
will acquaint you with several of the application’s basic features. 
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A Look at the Main Window 

 

Daq devices differ from one another in regard to functionality.  Functions that are not 
supported by a particular board [or device] will be grayed-out. 

 
DaqView Main Window (See Note 1) 

Channel Setup Tab Selected 
Main Window, a Brief Description of Button Control Functions 

# Item Description 
1 Charts Displays the DaqView Channel Display window. 
2 Bar Graph Meters Displays a bar graph meter. 
3 Analog Meters Displays an analog dial meter. 
4 Digital Meters Displays a digital meter. 
5 Start All Indicators Starts displaying data in the Reading column and any open Chart or Meters 

window. 
6 Stop All Indicators Stops displaying data in the Reading column and any open Chart or Meters 

window. 

7 View File Data Launches an independent post-data acquisition program, such as 
eZ-PostView, if installed. The data acquisition CD includes a PDF version 
post data acquisition documentation. 

8 Analog Output Displays the Analog Output window of the available DAC channels 
(see Note 2 and Note 3).  This feature is not used by TempBook. 

9 Digital I/O Displays the Digital I/O window. This feature is not used by TempBook. 
10 Counter/Timer Displays the Counter/Timer window. This feature is not used by TempBook. 
11 Waveform & Pattern Output Displays the Arbitrary Waveform and Streamed Output windows. 

This feature is not used by TempBook. 
12 Acquire Activates an acquisition of data to a file. 
13 Show ALL Channels Expands Analog & Scanned Digital Inputs spreadsheet to show all channels, 

whether active or not. 
14 Hide INACTIVE Channels Condenses the Analog & Scanned Digital Inputs spreadsheet, to hide 

channels that are inactive. 
15 Turn All Visible Channels ON  Turns all visible channels ON.   Hidden channels will remain off.  
16 Turn All Channels OFF  Turns all the channels OFF. 
17 Channel Reading  A toggle button that enables [or disables] the Channel Reading column of 

the Analog and Scanned Digital Input spreadsheet.   Some windows require 
the Channel Reading column to be disabled when changing channels or 
other parameters. This command is also available from the Data pull-down 
menu. 

Note 1: Although the GUI (graphical user interface) shown is from a DaqBoard/2000 application, it can be used to 
understand the GUI functionality for other device applications. Items 8, 9, 10, 11 are not used by TempBook. 

Note 2: Item 8 will only apply to DaqBook/2000 Series devices if a DBK46 card has been installed.  If so, 4 DAC analog 
outputs will be available at the P3 connector on the DaqBook front panel. 

Note 3: DaqBoard/2000 and /2000c have 2 DACs.  DaqBoards /2001, /2001c, /2003, /2003c, /2004, and /2004c each 
have 4 DACs.  No DACs are available on DaqBoard/2002, /2002c, /2005, /2005c. 



DaqView_g, pg.  4     967996 Document Module, 457-0909 

 

 

DaqView Main Window in a TempBook Application 
Channel Setup Tab Selected 

As noted in the previous table, and as can be seen in the above figure, when DaqView functions do not 
apply to a device the non-applicable buttons are grayed-out.  TempBook, for example, does not make 
use of DaqView’s Analog Output, Digital I/O, Counter/Timer, or Waveform & Pattern Output 
functions. 

 

Functionality Differences amongst DaqBoard/2000 Series and DaqBook/2000 Series 
DaqBook/2000A, DaqBook/2000E, and DaqBook/2000X have internal boards with the same acquisition-
related functionality as a DaqBoard/2005.  However, if a DBK46 option has been installed, the 
DaqBook/2000 Series device will function in the same manner as a DaqBoard/2001.   

Each of the DaqBoard/2000 Series Boards has a different I/O count.  DaqBoard/2001 has more I/O than 
any of the other boards [in the 2000 series].  All other 2000 series boards are essentially derivations of 
DaqBoard/2001. 

The differences in the boards are paralleled in the DaqView software.  Basically, if a board does not support 
a particular function, the related software feature will be disabled (grayed-out).  When using any of the 
information presented in this chapter, always take time to note whether or not it applies to your specific 
board.  

The following screen images represent DaqView Main Windows as they appear for the various devices. 
A device synopsis is provided just to the right of each screen. 
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DaqBoard/2000 and DaqBoard/2001 Main Window* 
 

*Also applies to DaqBook/2000 Series Devices when a DBK46 Analog 
Output option has been installed on the unit’s internal board. 

 
 

DaqBoard/2000 
DaqBoard/2001 
DaqBook/2000 Series (with DBK46) 

These devices have 16 Analog Input 
Channels, 40 Digital I/O Channels, 
and 6 Counter/ Timers. 

In addition:  

DaqBoard/2000 boards have 2 
Analog Output Channels. 

DaqBoard/2001 boards have 4 
Analog Output Channels. 

DaqBook/2000 Series devices have 
4 Analog Output Channels, providing 
that a factory-installed DBK46 option 
is in place on the internal board. 

 

 
DaqBoard/2002 Main Window – Channel Setup Tab Selected 

DaqBoard/2002 

These boards have 40 Digital I/O 
Channels and 6 Counter/ Timers. 

These boards have no Analog 
Channels.  Analog-related buttons are 
grayed-out and P1 (Analog Input) 
Channels do not appear in the 
spreadsheet. 

   

 

 
DaqBoard/2003 Main Window 

DaqBoard/2003 

DaqBoard/2003 has 4 Analog Output 
Channels.  The main window allows use of 
four pull-down menus and two toolbar 
buttons:  Analog Output, and Waveform 
and Pattern Output.  Remaining toolbar 
buttons serve no purpose with this board 
and are grayed-out.  DaqBoard/2003’s 
Main Window has no spreadsheet. 
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DaqBoard/2004 Main Window 

 

DaqBoard/2004 

DaqBoard/2004 has 4 Analog Output 
Channels, 40 Digital I/O Channels, and 6 
Counter/ Timers. 

The board has no Analog Input Channels, 
and for that reason no P1 designated 
channels appear on the spreadsheet portion 
of the window. 

 
DaqBoard/2005 Main Window* 

*Also applies to DaqBook/2000 Series Devices when no DBK46  
Analog Output option is installed on the unit’s internal board. 

 

DaqBoard/2005 
DaqBook/2000 Series (with no DBK46) 

DaqBoard/2005 and each member of the 
DaqBook/2000 Series has 16 Analog Input 
Channels, 40 Digital I/O Channels, 
6 Counter/Timers. 

The DaqBoard/2005 and the 
DaqBook/2000 Series devices have no 
Analog Output Channels, and for that 
reason the Waveform and Pattern Output 
button is grayed-out.   

An exception exists for the DaqBook/2000 
Series devices, providing that a DBK46 
Analog Output option has been installed.  
In this case 4 DACs will be available. 
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A DaqView Walk-Through 
The following walk-through is intended to familiarize you quickly with the DaqView data acquisition 
program.   The walk-through does not apply to DaqBoard/2003, as that board makes minimal use of 
DaqView.  DaqBoard/2003 users can, however, go through the following steps with the simulated 
instrument.  

(1) Open DaqView.  If your Daq device or DBK signal-conditioning units are not connected you can 
select Simulated Instrument as your device. 

 

(2) From DaqView’s File menu, select 
Authorization. 

 

 

Note:  Step 3 does not apply to DaqBook/2000A, 
DaqBook/2000E, or DaqBook/2000X. 

 

(3) If you ordered DaqView, enter the 
Authorization Code found on a separate sheet and 
click the Apply Code button. 

If you have no Authorization Code you can click 
the Start 30-Day Trial button to enable a 
temporary version of DaqView.  Note that you can 
also order DaqView upgrades “online.”   

 

 

 

(4) To familiarize yourself with the three windows 
available from DaqView’s main window, click the 
tabs Channel Setup, Acquisition Setup, 
and Data Destination.  These are not available for 
DaqBoard/2003. 

 

Channel Setup displays a spreadsheet for viewing 
and changing the configuration of analog and 
scanned digital input channels. Each row is 
dedicated to a single channel. 

 

 

Since each DaqBoard/2000 Series board has 
different enabled functions, your board’s actual 
screen shots may appear slightly different than 
shown in the example screen shots. 

For the most part, the following screen images will 
relate closely to DaqBook/2000 Series devices. 
Exceptions will be noted, when applicable. 
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Acquisition Setup displays a window that includes 
parameters for triggering and configuring the scan. 
These settings are used when an acquisition to disk 
is started with the toolbar’s Acquire button. When 
the trigger is satisfied, scans are collected at the 
selected scan frequency and stored to disk in the 
designated file. Note that these parameters cannot 
be altered while an acquisition is in progress. 

 

 

 

Data Destination provides a means of designating 
the desired file formats and directories for acquired 
data. 

 

From DaqView’s Device menu, select Configure 
Hardware Settings. 

The window Configure System Hardware will appear.  Whenever expansion cards are added, you must 
update this window. 

On the left side of the window, select any channel’s pull-down box to reveal the external connection 
options. Besides the default, direct signal connection, you can choose among the DBK option cards and 
modules. The right side of the screen sets up digital connections if your Daq device is so equipped. 

User’s of certain DBK cards will need to select an internal clock speed of 100 kHz as discussed in the 
following section. 

Click OK to return to DaqView’s main window. 
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Configure System Hardware 

Screen Sample for DaqBoard/2000, /2001, /2005 and 
for DaqBook/2000 Series Devices. 

 
Configure System Hardware 

 Screen Sample for DaqBoard/2002 and /2004. 

DaqBoard/2002 and DaqBoard 2004 have no 
Analog Input, thus the Analog I/O Option Cards 
sections of the screen are grayed-out.  
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The information in this block only applies to DaqBook/2000 Series Devices and to  
DaqBoard/2000, /2001, and /2005. 

 

Selecting 100 kHz Internal Clock Speed 
User’s of DBK12, DBK13, DBK15, DBK19, DBK52, DBK53, or DBK54 need to select 
100 kHz internal clock speed as discussed below. 

 

In the Configure Systems 
Hardware window, after 
selecting DBK12, DBK13, 
DBK15, DBK19, DBK52, 
DBK53, or DBK54 you will 
need to select an internal 
clock speed of 
100 kHz. 

 

 

To select an “Internal Clock Speed” of 100 kHz: 

(1) Select the Acquisition Setup tab on DaqView’s main window. 

(2) On the lower left corner of the window, under Scan Configuration, 
click the Preferences button. 
 
The Advanced Options window will appear (following figure). 
 
Note:  The Advanced Options box can also be accessed from the 
Windows pull-down menu. 

 

(3) Under “Internal Clock Speed,” 
select 100 kHz. 

(4) Click the OK button to return to 
DaqView’s main window. 

 

This completes the clock setting 
procedure. 

Continuing with the “Tour of DaqView”… 

 

Select the Channel Readings button. If in the Simulated Instrument mode, the Reading 
column of the Analog & Scanned Digital Inputs spreadsheet will display simulated data. 
Selecting the Channel Readings button again will freeze the Reading column’s display. 
If working hardware is connected, the readings will quantify actual signals. 

 

To acquire data to a file, press the Acquire button. For simulated hardware, you will be 
prompted to enable a manual trigger. Binary data is acquired to a file (with default name 
of daqv.bin). 

 

This button is used to launch an independent post-data acquisition program, such as  
eZ-PostView.  For details, refer to the eZ-PostView PDF document that is included on 
your data acquisition CD.  You can access the document via the <View PDFs> button 
located on your CD’s intro-screen. 
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Channel Setup 
The Channel Setup window (first tab on lower portion of main window) displays the analog and scanned 
digital input channels and allows you to configure them. Each row shows a single channel and its 
configuration. The number of rows may vary, but each row has seven columns. Some columns allow blocks 
of cells to be altered at the same time (clicking a column header can select the entire column). Other 
columns allow only a single cell to change. The table summarizes the function of each column. 

 

 
 

Channel Setup Tab Selected 
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Channel Setup Window 
Column Description 

CH  The channel number (cannot be changed from this window).  This number includes the main channel 
number and the expansion board number and channel (if used).  Expansion channels are configured 
using the Hardware Configuration window described later in this module. 

On This column allows you to select whether data will be collected from that channel.  When a cell or 
block of cells in this column is selected, a selection box will appear that allows “Yes” to enable or 
“No” to disable the channel.  Double-clicking a cell in this column will toggle the channel status.  The 
Edit menu allows you to Make All Channels Active or Make All Channels Inactive. 

Type  This column allows you to set the gain or input type for each channel.  The gains and types will vary 
among the option cards.  A block of cells in this column can be selected for multiple channels with 
the same type of option card.  Double-clicking a cell will select the next available gain or type. 

Note: If one of the P3 counters is active in the scan, and Type is selected for frequency 
measurement, low frequency input signals will require a slow scan rate setting for accurate 
measurement. For example, for a frequency of 200 Hz, set the Scan Rate (in the Acquisition Setup 
window) for 1 scan per second or 6 scans per minute. 

Polarity This column shows the channel polarity (unipolar or bipolar) for each channel.  The polarity can be 
programmed here on a per channel basis when using a DaqBook/200, /216, /260 and any DaqBoard 
[ISA or PCI type], or a DBK15 Universal Current/Voltage expansion card.  When using any other 
Daq*s, this column is set in the Hardware Setup window.  For selected cells that can be changed, a 
selection box will display “Unipolar” or “Bipolar”.  Double-clicking in a cell will toggle the polarity.  If 
the hardware cannot program the polarity, no selection box will be displayed. 

Label This column contains a descriptive name for the input channel.  The default label is the channel 
number, but it can be changed to any 8 characters and must be unique.  This label is used when 
selecting a channel in the analog trigger and chart selection lists. 

Units This column allows you to change the engineering units of each channel and apply a linear equation 
to the Daq data.  When a cell or block of cells in this column is selected, the analog input box 
displays entry options in a pull-down box.  Selecting “mx+b” allows you to define m and b and the 
engineering units label.  The engineering units will then be displayed in the “Units” column and the 
“mx+b” equation will be applied to the reading from the Daq before the reading is displayed or written 
to disk.  The X in this equation is the voltage read back from the Daq (or degrees Celsius for a 
DBK19).  For example, if a Daq channel is configured as bipolar and unity (×1) gain, the default 
voltage would be ±5 V.  This corresponds to an m of 1, a b of 0, and a unit of V.  V can be changed 
to millivolts by setting m to 1000 and units to mV.  The Units column can also be used to perform a 
software calibration of the Daq.  This is done by reading known inputs at two different points of the 
input voltage range (usually at 0 and full-scale) and solving the equation y = mx + b.  The full-scale 
voltage, which changes according to the gain of the channel, is 5 V/gain for bipolar channels and 10 
V/gain for unipolar channels. 

Reading This column displays the device’s analog or scanned digital input readings.  This column cannot be 
altered by the user and is enabled by selecting Enable Input Reading Column under the Data menu 
or by selecting “Start/Stop All Indicators” under the window menu.  This column will update the 
readings as fast as the computer will allow.  The spreadsheet cannot be altered while the input 
reading column is enabled. 
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Acquisition Setup 
Selecting the second tab of the main window displays the Acquisition Setup window. The four main parts of 
this window include setup parameters for triggering and configuring the scan. These settings will be used when 
an acquisition to disk is started by selecting “Acquire” (last item on the toolbar). When the trigger is satisfied, 
the scans are collected at the selected scan frequency and stored to disk in the designated file. 

 

 
Acquisition Tab Selected 

Note: Clock Divider appears only when SyncSlave is selected. 
Acquisition Setup Window 

Parameter Description 

Pre-Trigger The number of scans to acquire before the trigger event. 

Trigger Event Selects the trigger source, depending on the device. Possible trigger sources include: 

Immediately – arms and executes the trigger immediately. 
Key Hit – arms the acquisition and waits for the user to press a key. 
External TTL Rising/Falling – waits for a rising or falling edge slope on P1-25. 
Hardware Rising/Falling Edge – monitors value with hysteresis on selected channel; triggers 
when parameter is satisfied. 

 

These 6 triggers 
apply only to 
DaqBoard/2000 
Series Boards and 
to 
DaqBook/2000 
Series Devices. 

 

External TTL High/Low – waits for a TTL high or low level on pin 25 of connector P1. 
Hardware Above/Below Level – monitors value on selected channel; triggers when parameter is 
satisfied. 
Above/Below Level – monitors value on selected channel; triggers when parameter is satisfied. 
Rising/Falling Edge – monitors value with hysteresis on selected channel; triggers when 
parameter is satisfied. 
Inside/Outside Window – monitors upper and lower values on selected channel; triggers when 
parameters are satisfied. 

Digital Pattern – monitors 8-bit pattern on selected digital input channel; triggers when 
parameters (less/greater than or equal to/not equal to) are satisfied. 
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Stop Event 

 

 The Stop Event panel is used to select the event that stops the scanning, depending on the 
device connected. Possible sources include: 
Number of Scans - can range from 1 to 100,000,000. A scan includes all of the channels that are 
marked as “On” in the Analog & Scanned Digital Inputs spreadsheet. 
Key Hit – stops acquisition when the user presses a key. 

These 4 Stop 
Events apply 
only to 
DaqBoard/2000 
Series Boards 
and to 
DaqBook/2000 
Series Devices. 

Above/Below Level – monitors value on selected channel; stops scan when parameter is 
satisfied. 
Rising/Falling Edge – monitors value with hysteresis on the selected channel; stops the scan 
when the parameter is satisfied. 
Inside/Outside Window – monitors upper and lower values on selected channel; stops scan when 
parameters are satisfied. 
Digital Pattern – monitors 8-bit pattern on selected digital input channel; stops scan when 
parameters (less/greater than or equal to/not equal to) are satisfied. 

Scan Configuration 

 

Clock Source 
Drop-down list 

Provides a means of choosing one of the following options: 

 
Internal – selects the device’s internal clock 

External – selects an external user-supplied clock 

SyncMaster – Sets the device as the Master and selects the 
internal pacer clock.  (DaqBook/2000 Series Only) 

SyncSlave –  Sets the device as a Slave unit and uses the clock 
of a Master device to which it is connected.  In addition, when 
SyncSlave is selected a Clock Divider box appears (right-side 
figure).  The value of the divider can be set from 1 to 65535.  This 
sets the scan rate to a fraction of the Master rate.  The fastest 
rate is set by using a value of “1.”  A setting of “10” would result in 
a scan once every tenth clock pulse.  The slowest possible setting 
is “65535.”  (DaqBook/2000 Series Only) 
 

 
Clock Divider 

The Clock Divider only 
appears when SyncSlave 
is selected from the drop-
down list. 
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Clock Source 
<Preferences> 
Button 

The Preferences button brings up a Preferences box (following figure), which provides a means 
of selecting and/or adjusting the following options: 

 
Internal Clock Speed -  For DaqBoard/2000 series boards, the default setting is 200 kHz.  Note 
that the use of certain DBK cards requires a setting of 100 kHz, as discussed elsewhere in this 
manual. (For DaqBook/2000 Series & DaqBoard/2000 Series Only). 
 
Pacer Clock – Enable or disable a pacer clock.  
(For DaqBook/2000 Series & DaqBoard/2000 Series Only). 
 
File Conversion – Enable or disable a “delete Raw Binary files” notice. 
 
Calibration Table – Select Factory or User calibration table.  (For DaqBook/2000 Series & 
DaqBoard/2000 Series Only). 
 
Calibration File –  Included on a separate disk, the calibration file fine tunes the accuracy of the 
device.  Read the readme.txt file on the disk for more information. 
Zero Offset Adjustment –Protects against drift 
Channel Display –Enables the expansion option type in the channel list. 

 

 
Preferences Box  

The following sections of 
the “Preferences” box 
apply only to the 
DaqBoard/2000 Series 
Boards and to 
DaqBook/2000 Series 
Devices: 

• Internal Clock Speed 
• Pacer Clock 
• Calibration Table 
 
Zero Offset Adjustment 
applies only to DBK19, 
DBK52, and TempBook 

Scan Rate The scan frequency can be set in units of seconds, milliseconds, minutes, or hours via a pull-
down box. Typing into the numeric field changes the rate. The maximum scan frequency is 
dependent on the number of channels that are enabled and whether or not averaging is enabled. 
Enabling more channels or averaging will lower the maximum scan frequency. 

Averaging The checkbox allows averaging of the analog input data to be enabled or disabled. Averaging can 
be used to increase the effective accuracy of a noisy signal. Averaging will increase the actual 
scan frequency and number of scans, but the perceived scan frequency and number of scans 
(which is set by DaqView) does not change. 

Note:   These parameters cannot be altered during an acquisition. 
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Data Destination 
Selecting the third tab of the main window displays the Data Destination window. The two parts of this 
window let you designate the directory for acquired data and the desired file formats. 

 
Data Destination Tab Selected 

 
Data Destination Window 

Parameter Description 
 
Data Destination 
Data File Name Acquired data is saved to this file name. This file always has a “.bin” file extension. 

 
Base Directory This is the directory from which other directories are created to store the converted and 

acquired data. You can type in changes or use the Browse button to direct files elsewhere, 
including other disk drives. 

 
Auto Re-Arm 
 With the Enable Auto Re-Arm box checked, you can specify when file conversions are 

performed and the sequence range of incrementing file names. 
 
Binary Data and Selected Format File List 
File Conversion 

Preferences 
This button lets you select the format of saved data. Selections include: DIAdem, ASCII text, 

DADiSP, DASYLab, MATLAB, PostView Binary, Snap-Master Binary, .Wav, and UFF 
(Universal File Format). The tree shows where the various formatted files will be saved on 
disk. 

 The graphic display shows the directories and files created during acquisition. Double-clicking 
a directory brings up Windows Explorer. Double-clicking a file brings up any program 
associated with the file type. 
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Pull-Down Menus 
Some (but not all) items in the pull-down menu can also be enabled from the toolbar. Their description in 
the toolbar section is more detailed than presented in this section. 

File 
File Menu Items and Descriptions 

New Set all parameters to their startup, default setting. 
Open Set all parameters as directed by a specified setup file. 
Save Save the existing configuration for later recall (overwrites the existing version). 
Save As Saves the existing configuration for later recall; asks whether to overwrite the original 

version or save under a new filename. 
Authorization Displays the Authorization window for entering the Authorization Code.  
Exit Leave the DaqView program. 

 

Edit 
Edit Menu Items and Descriptions 

Hide Inactive 
Channels 

This command collapses the spreadsheet to show only those channels that are turned on. 
It can be selected repeatedly as needed. 

Show All Channels This command shows all channels, whether turned on or off. 
Make All Channels 
Inactive 

This command places a “No” in the On field of all channels.  To scan only a few channels it 
may be easier to make all channels inactive, then turn on the desired channels. 

Make All Channels 
Active 

This command places a “Yes” in the On field of all of the channels. 

Fill Down 
F8 

For multiple cells selected within a column, this command copies the value in the top cell to 
all the cells below. 

 

Data 
Data Menu Items and Descriptions 

Acquire This command arms the hardware for an acquisition to disk.  When the trigger is satisfied, 
the acquisition begins.  All of the interactive I/O controls are disabled while the system is 
armed.  No acquisition parameters can be altered at this time. 

Convert Existing 
Files 

During an acquisition, a raw binary file is created and updated as data is read. This 
command lets you convert raw binary files to the selected formats. This allows you to 
convert files that may not have been converted when the data was acquired. 

Enable Input 
Reading Column 

This command reads the analog inputs and scanned digital inputs and puts the numeric 
values in the spreadsheet in the “Reading” column. If the Reading column is already 
enabled, this command disables it. 
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Window 
Window Menu Items and Descriptions 

Charts Displays the charts window. 
Bar Graph Meters Displays a bar graph meter. 
Analog Meters Displays an analog dial meter. 
Digital Meters Displays a digital meter. 
Start All Indicators Starts displaying data in the Reading column and any open Chart or meters window. 
Stop All Indicators Stops displaying data in the Reading column and any open Chart or meters window. 
View File Data Launches the post acquisition data analysis application. 
Analog Output Displays the analog output window.        Does not apply to TempBook. 
Digital I/O Displays the digital I/O window.              Does not apply to TempBook. 
Counter/Timer Displays the counter/timer window.         Does not apply to TempBook. 
Waveform & 

Pattern Output 
Displays the arbitrary waveform and streamed output windows. 

                                                            Does not apply to TempBook. 
Preferences Displays a preferences box that shows user-selectable options the particular Device 

model may have.  For example, with a DaqBoard/2001, the following preferences 
can be set. 

 
 
Note: DaqBoard/2000 Series and DaqBook/2000 Series devices can have their 

internal clock speed set to 200 kHz (default) or 100 kHz.   However, the use of 
certain DBK cards requires a setting of 100 kHz, as discussed elsewhere in this 
document. 

 
The Pacer Clock checkbox lets you enable a clock output. 

 
 
Device 

Device Menu Items and Descriptions 
Select Device Provides a means to select an actual connected device, or a simulated instrument. 
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Configure 
Hardware 
Settings 

Opens the Configure System Hardware window that lets you tell the software how the 
hardware is set up. Setup sections include: Analog I/O Option Cards (DBKs), Digital 
Option Cards, 
A/D Input Polarity, A/D Signal Reference, and D/A External Reference. 

Options that do not apply to a particular device will be grayed-out when applicable. 

 
Configure System Hardware 

 
The Analog I/O Option Cards section lets you assign DBK expansion cards to the 16 

analog input channels. If no expansion cards are added, leave the default value 
(Direct Signal Connection) on all 16 channels. As expansion cards are added, this 
window must be updated. 

Selecting a DBK expansion board will add channels in the main window’s Analog & 
Scanned Digital Inputs spreadsheet. Channels associated with DBK expansion 
boards will also have their own gains or modes to choose from in the analog input 
spreadsheet. If needed, a dialog box will appear and allow you to set sub-channel 
addresses or other parameters. 

If using the DaqBook/100, DaqBook/112 orDaqBook/120, set the radio buttons for 
Single-Ended or Differential and Bipolar or Unipolar to match the settings of the 
corresponding hardware jumpers (the default hardware settings are Single-Ended 
and Bipolar). When Differential is selected, only 8 analog inputs are available. When 
analog expansion boards are connected, set the Daq for Single-Ended. 

If using the DaqBook/100, DaqBook/200, DaqBook/260, DaqBoard/100A, 
DaqBoard/200A, a DaqBoard/2000 Series or a DaqBook/2000 Series device, the 
Digital Option Cards section lets you configure the digital I/O hardware. If no DBK20 
digital expansion boards are connected, three 8-bit I/O ports are accessible from the 
main window.  Six additional 8-bit ports are made available in the main window for 
each DBK20 added. 

Make sure this window is kept updated for the actual hardware used. 

 

User’s of DBK12, DBK13, DBK15, DBK19, DBK52, DBK53, or DBK54 
need to select 100 kHz internal clock speed as discussed on page 10 of 
this document module. 

Session Status Displays the currently selected device, its alias, and whether DaqView can recognize 
it. 

 
 
Help 

The Help menu provides access to the on-line Help file. 
About provides the current software version number. 
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Toolbar Items 
Main Window Buttons 

Each item in the main window toolbar has its own icon and is accessible from the pull-down menu. Placing 
the cursor on the icon and clicking the mouse button enables the tool or opens the corresponding window. 

When a function does not apply to a particular board, the toolbar button will be grayed-out.  The beginning 
of this chapter includes toolbar screen shots for each of the DaqBoard/2000 Series boards. 

 
Main Window Toolbar Items 

Item 
# 

Item Description 

1 Charts Displays the DaqView Channel Display window. 
2 Bar Graph 

Meters 
Displays a bar graph meter. 

3 Analog Meters Displays an analog dial meter. 
4 Digital Meters Displays a digital meter. 
5 Start All 

Indicators 
Starts displaying data in the Reading column and any open Chart or Meters window. 

6 Stop All 
Indicators 

Stops displaying data in the Reading column and any open Chart or Meters window. 

7 View File Data Launches an independent post-data acquisition program, such as eZ-PostView, if 
installed.  The data acquisition CD includes a PDF version post data acquisition 
documentation.  

8 Analog Output Displays the Analog Output window of the available DAC channels 
(see Note 2 and Note 3).  This feature is not used by TempBook. 

9 Digital I/O Displays the Digital I/O window.   Does not apply to TempBook. 
10 Counter/Timer Displays the Counter/Timer window.   Does not apply to TempBook. 
11 Waveform & 

Pattern 
Output 

Displays the Arbitrary Waveform and Streamed Output windows. 
Does not apply to TempBook. 

12 Acquire Activates an acquisition of data to a file. 

Note 1: Items 8, 9, 10, 11 are not used by TempBook. 

Note 2: Item 8 will only apply to a DaqBook/2000 Series device if a DBK46 card has been installed.  If so, 4 DAC analog 
outputs will be available at the P3 connector on the unit’s front panel. 

Note 3: DaqBoard/2000 and /2000c have 2 DACs.  DaqBoards /2001, /2001c, /2003, /2003c, /2004, and /2004c each 
have 4 DACs.  No DACs are available on DaqBoard/2002, /2002c, /2005, /2005c. 

Channel Setup Buttons 

  Show All Channels, Hide Inactive Channels 
These toolbar buttons collapse or expand the Analog & Scanned Digital Inputs spreadsheet to show all 
channels, whether active or not, or to hide those that are inactive. These commands are also available from 
the Edit pull-down menu. 

   Turn All Visible Channels On, Turn All Visible Channels Off 
These toolbar buttons can turn all the channels ON or OFF at a single stroke. This feature is convenient 
during setup and troubleshooting or if only 1 or 2 channels must be set differently from the rest. Both these 
commands are also available from the Edit pull-down menu as Make All Channels Active and Make All 
Channels Inactive. 

  Channel Readings 
This toolbar item enables/disables the Reading column of the Analog and Scanned Digital Input spreadsheet 
to provide a numeric view of incoming data. This function toggles on and off when the button is repeatedly 
selected. Some windows require the Reading column to be disabled while changing channels or other 
parameters. This command is available from the Data pull-down menu as Enable Input Reading Column. 
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Charts and Meters Buttons 
Additional tool icons in charts and meters include the following.  Note that other buttons, for DaqViewXL 
and the post-acquisition data analysis program, are discussed later. 

 

 

Button Display Windows 

  Charts 
This toolbar item displays real-time data in 
a strip-chart format for several channels on 
the DaqView Channel Display window.  
Charts are enabled by selecting the 
triangular “Play” button on the top left (see 
figure).  Before “playing”, at least one 
chart must be assigned to an active channel 
through the drop-down list on the right side 
of the chart.  For the selected channel, you 
can change the minimum and maximum 
values as needed.  This command can also 
be enabled from the Window pull-down 
menu. 

Data is read and displayed in the charts, 
meters, and Readings column as fast as the 
computer will allow.  When an acquisition 
to disk has begun using the Acquire 
command, the charts, meters, and the 
Reading column take a lower priority, 
updating only when there is time in the 
acquisition-to-disk task.  Thus, the data 
seen in the charts may not be the same as 
on the disk.  As the scan rate is increased, 
the acquisition-to-disk task will take up 
more processor time and the charts will be 
unable to keep up. 

 
DaqView Display Charts 
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  Bar Graph Meters 
Selecting the Bar Graph Meter icon brings up 
the Bar Graph window to display several 
channels in bar graph format.  To activate the 
display, select the Start button on the left side 
of the toolbar (or Start All Indicators in the 
pull-down menu or in the toolbar).  You can 
vary the number of channels displayed by 
selecting the input box at the end of the 
toolbar.  The Grid tool (next to last item on 
toolbar) is used to arrange the display for 
convenient reading.  The pushpin icon in the 
center of the toolbar locks this window on 
top of other windows until you unlock it by 
selecting the pushpin again.  Right-click on a 
meter to bring up an option menu. 

 

  Analog Meters 
Selecting the Analog Meter icon brings up 
the Analog Meters window to display several 
channels in a dial/gage format.  To activate 
the display, select the Start button on the left 
side of the toolbar (or Start All Indicators in 
the pull-down menu or in the toolbar).  You 
can vary the number of channels displayed by 
selecting the input box at the end of the 
toolbar.  The Grid tool (next to last item on 
toolbar) is used to arrange the display for 
convenient reading.  The pushpin icon in the 
center of the toolbar locks this window on 
top of other windows until you unlock it by 
selecting the pushpin again.  Right-click on a 
meter to bring up an option menu. 

  Digital Meters 
Selecting the Digital Meters icon brings up 
the Digital Meters window to display several 
channels in numeric format.  To activate the 
display, select the Start button on the left side 
of the toolbar (or Start All Indicators in the 
pull-down menu or in the toolbar).  You can 
vary the number of channels displayed by 
selecting the input box at the end of the 
toolbar.  The Grid tool (next to last item on 
toolbar) is used to arrange the display for 
convenient reading.  The pushpin icon in the 
center of the toolbar locks this window on 
top of other windows until you unlock it by 
selecting the pushpin again.  Right-click on a 
meter to bring up an option menu. 

 

 

 
Bar Graph Window 

 
Analog Meters Window 

 
Digital Meters Window 
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Properties of Meter Windows 

 
Bar Graph Meters Properties 

Scale Tab Selected 

 
Digital Meters Properties 

Limits Tab Selected 

 
Analog Meters Properties 
Miscellaneous Tab Selected 

 
The meter windows simulate the look of 3 popular meter types: the bar graph, the analog dial, and the 
digital readout.  Within each meter type, you can adjust their display properties to fit your needs.  While in 
the meter window, place the cursor in the display area and click the right mouse button; then select 
Properties.  A Properties window will appear and allow you to: 

• Scale - set the high and low points and the format (number of decimal places) 
• Limits - set the high and low points and whether to display these limits 
• Misc - set option to show the Trend Indicator and/or the Peak Hold Indicators. 

   Start (or Stop) All Indicators 
These buttons use the same icons as many CD players (right-pointing triangle for start; square for stop).  To 
change some parameters, you may have to stop the data display.  The Start and Stop All Indicators buttons 
affect several windows if open, including: Reading column, Charts, Bar Graph Meters, Analog Meters, and 
Digital Meters. 

Note: You can start or stop any of these active windows separately using their own Start, Stop (or Pause) 
buttons. 

  Analog Output Window 
Note:  This feature is not used by 
TempBook. 

The analog output window provides 
interactive access to the analog outputs on the 
DaqBoard/2000, /2001, /2003, /2004, 
DaqBoard/2000c, /2001c, /2003c, and /2004c.  
If a DBK46 is installed in a DaqBook/2000 
Series device, access to 4 DACs (DAC0, 
DAC1, DAC2, and DAC3) is available.  
When set to the default internal reference, 
these outputs can be set from 0 to +10 VDC. 

The output voltage can be with the slide 
control, or by placing the cursor in the 
numeric field and entering a valid voltage 
value.  Selecting the Execute button sends the 
voltage values to the outputs. 

Two versions of this window exist.  If a 
DBK2 or DBK5 (see Note 1) is active in the 
Analog & Scanned Digital Input spreadsheet, 
the window will accommodate voltage and 
current output in addition to the DAC 
reference. 
Note 1:  DBK2 and DBK5 cannot be used with DaqBoard/2002, /2003, or /2004. 

Note 2:  This window is not available when the arbitrary waveform window is visible. 

 
 

 
Analog Output Window (with and without DBK2 & DBK5) 



Document Module,  457-0909, rev 2.0 967996 DaqView_g, pg. 25 

  Digital I/O Windows 

The Digital I/O Windows apply to: 
   DaqBook/100, /200, /260 
   DaqBoard/100A, /200A 
   DaqBoard/2000, /2001, /2002, and /2004 
   DaqBook/2000 Series Devices 
    

Note:  This feature is not used by TempBook. 

 
Asynchronous Digital I/O Window –  

P2 Digital I/O Tab Selected 

 
Asynchronous Digital I/O Window –  

P3 HS (High Speed) Digital I/O Tab Selected 

The digital I/O windows are displayed when the Digital I/O button on the main window is selected. These 
windows provide interactive control of all configured digital I/O ports (as configured in the Configure 
System Hardware window). The base unit has the three 8-bit ports of P2 that can be configured as either 
inputs or outputs. If high-speed digital I/O is supported (on connector P3), a second window is available 
for configuring inputs and outputs. Up to twenty 8-bit ports can be accessed when expansion boards are 
added. When the Execute button is pressed, all ports configured as outputs will be updated and all input 
ports will be read. 

  Counter/Timer Window 
Note:  This feature is not used by TempBook. 

The Counter/Timer function is used by DaqBoard/2000 Series Boards (except /2003).  
The Counter/Timer function is also used by the DaqBook/2000 Series Devices. 

Two Counter/Timer modes are available. 

• Totalize Input – Counts rising or 
falling edges of signals from the 
related pin on P3 adapter. Each 
channel has its own Reset button. 

 

• Square Wave Generator Output 
– Outputs a square wave on each of 
2 channels with a selectable 
frequency and duty cycle. 

 

Note: When using DaqBoard/2000 Series or DaqBook/2000 Series devices, channels that are enabled 
in the scan cannot be used from the asynchronous counter/timer window. 
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 Waveform & Digital Pattern Output Window 
 

• To use this feature with DaqBook/2000 Series Devices, a DBK46 Analog Output card must be 
installed on the unit’s internal board. 

• This window can not be used with DaqBoard/2002 or DaqBoard/2005, as these two boards have 
no DACs. 

• This feature is not used by TempBook. 

 

Within DaqView there exists a waveform 
mode for devices that have analog output 
channels.  DaqView allows the associated 
DaqBoard/2000 Series DACs to be 
configured in interactive mode or 
waveform mode.  This also applies to 
DaqBook/2000 Series devices, providing 
an optional DBK46 Analog Output card is 
installed on the unit’s internal board. 

The window has two tabs: Analog 
Waveform and Streaming Output.   

• Selecting the Analog Waveform tab 
accesses the standard analog output 
window. 

• Selecting the Streaming Output tab 
accesses the arbitrary waveform 
window. 

Note: This window is not available when 
the analog output window is visible. 

The following material identifies the 
functions of various buttons and regions of 
the window.  Refer to the screen shot at the 
right as needed. 

 
Waveform and Digital Pattern Output Window – 

Analog Waveform Tab Selected 

In the Waveform Type box, you can select a standard function generator waveform (sine, square, triangle, 
sawtooth) or a freehand drawing.  In Freehand, move the mouse to the waveform window and draw a 
waveform using the left mouse button. 

The Save Waves button allows you to save the values of each displayed waveform to disk in an ASCII 
format. The files created are compatible with spreadsheets and word processors, allowing you to 
numerically inspect and/or alter the saved waveforms.  

Sample Waveform File Format Examples 

One Channel Two Channels 

2043<CR> 2432<TAB>293<CR> 
1019<CR> 394<TAB>345<CR> 
300<CR> 2934<TAB>3456<CR> 
923<CR> 743<TAB>875 <CR> 

 

 

 

 

 

In the two-channel example (to the immediate 
left), the entry preceding the  <TAB> is for 
the first channel and the entry after the TAB is 
for the second channel. 

 

The Load Waves button reads any ASCII file of numbers up to the number of points specified in the 
Updates per Channel field. 

To use this feature with a DaqBook/2000 
Series Device, a DBK46 Analog Output 
card must be installed on the unit’s 
internal board. 
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The Copy Waves and Paste Waves buttons use the system clipboard to post and receive waveform data 
from all DAC channels.  The data formats are identical to the Save and Load operations. Copy and Paste are 
recommended for use with spreadsheets to numerically inspect and/or modify waveforms.   Waveforms can 
also be copied and pasted from the popup menu that is displayed when the mouse is right clicked over the 
Waveform display.   The waveform selected in the DAC selection listbox is the target of the Cut or Paste.  
If multiple channels of data are on the clipboard, you can select the one that you want to paste into the 
selected DAC channel. 

The size of the memory buffer allocated for each DAC channel is determined by the number of updates that 
you specify.   Different Daq devices have different limits on the maximum updates that can be specified. 

You can select one of three clock sources to pace the DAC output.  The three options are as follows:     

• DAC Pacer with a rate set in the Sample Update Rate field. When using the DAC pacer, the Update 
Rate field controls the speed at which the DAC is updated. 

• Acq Pacer, the clock used by the analog input section of the DaqBoard. Using the Acq pacer clock 
synchronizes the update of the DAC output with the analog input data collection. 

• External TTL.  Update rate is controlled by the rate of the clock signal applied to the external input 
pin. 

Note:  If the DAC Pacer clock is selected, you must enter the update rate that paces the DAC outputs. 

The selection for the DAC channel for which you want to create a waveform, is made in the DAC selection 
listbox,.   From the same listbox you can control the channel's output by clicking the checkbox on or off.   
Note that DaqBoard/2000, having two DACs allows for two channels to be selected.  DaqBoard/2001, 
2003, and /2004 have four DACs and allow for up to 4 DAC analog output channels to be selected.  
DaqBook/2000 Series devices, that have a DBK46 Analog Output card installed, have 4 DAC analog output 
channels.  A DaqBook/2000 Series device without a DBK46 has no analog output. 

In the Waveform selection box, you can select a standard function generator waveform (sine, square, 
triangle, sawtooth) or an arbitrary freehand drawing. In arbitrary mode, move the mouse to the waveform 
window and draw a waveform using the left mouse button.   The drawn waveform will be loaded into the 
channel selected in the DAC channel listbox.   You can also create a waveform by right clicking the mouse 
with the cursor over the waveform window.   Select the waveform type from the resulting popup menu.   
Repeat this process for each channel in the DAC selection listbox. 

To start the waveforms playing on the DACs, click the Start Waveforms button. 

Auto Scale Waveform 

DaqView provides an easy method to determine the upper and lower extents of the selected DAC 
waveform.    Simply right click the mouse over the Waveform display, and select the Auto Scale item from 
the popup menu.   DaqView scans the waveform for the highest and lowest values, then sets the upper and 
lower waveform range fields to these values.   This causes the waveform to be displayed full scale within 
the waveform display.    

This is useful if the waveform is off scale on the high or low end (indicated by the range input field color set 
to red) and you want to bring it back to a full scale view. 

Auto Fit Waveform 

The DaqView Auto Fit feature is similar to Auto Scale.   However, Auto Fit causes the data to be re-scaled 
so it fits full scale in the range defined by the values in the upper and lower range input fields. 

 Note: For some Daq hardware, when hardware triggering has been selected to trigger an acquisition, DAC1 
is used internally to supply the desired threshold voltage. In this case, CH 1 is not available for 
waveform output. The Copy Waves and Paste Waves buttons use the system clipboard to post and 
receive waveform data.  The data formats are identical to the Save and Load operations.  Copy and 
Paste are recommended for use with spreadsheets to numerically inspect and/or modify waveforms. 

To start the waveforms playing on the DACs, click the Start Waveforms button. 

Note: When the analog input section is set for analog input triggering, DAC1 is used internally to supply the 
desired threshold voltage.  In this case, DAC1 is not available for waveform output. 
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For DaqBook/2000 Series Devices (with DBK46 installed); and for 
DaqBoard/2000, /2001, /2003, /2004, and DaqBoard/2000c, /2001c, /2003c, and /2004c. 

 

Note:  To use this feature with a DaqBook/2000 Series Device, a DBK46 Analog Output card must be 
installed on the unit’s internal board. 

 

Selecting the Streaming Output tab brings 
up the window to configure continuous 
streamed output via one or more DACs, or 
digital outputs via the P3 16-bit port. 

• Analog or digital output is chosen 
from the Data Selection section of the 
Streamed Output window. 

• The Data Source section selects the 
file name and type (ASCII or binary). 

• Within the Output Control section, you 
can select to send all samples or a 
portion, and whether to continuously 
repeat or stop after a specified count. 

• The clock source can be an internal or 
external DAC clock, or an internal or 
external pacer clock. 

• The Start button initiates a streamed 
output. 

 

 

  Acquire 
The Acquire selection activates an acquisition of data to file.  The Event option under the Trigger Setup 
portion of  the Main window determines when the Acquire process is initiated.  The Event selections are 
detailed in the Acquisition Setup section of this chapter.  After Acquire is selected, the process is automatic 
beginning with the DaqView Armed screen.  This screen posts the Trigger Armed time as well as the 
Trigger Event information.  The Acquire process makes use of the Data File Setup parameters to format 
data collection. 

Once the Trigger Event occurs, the DaqView Triggered screen appears.  This screen allows you to witness 
the data sampling parameters you set in the Main window prior to initiating the Acquire process as well as 
the progress of the data acquisition. 

If file conversion is selected, the Acquire process concludes by converting the generated .BIN file from 
binary to ASCII data.  The resulting file is saved under a user-specified directory and file name or as a 
default under the DaqView subdirectory as DAQV.TXT.  This .TXT file is available for data processing or 
analysis by various software packages such as DaqViewXL. 
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DaqViewXL  
Overview ……1 
Program Requirements ……1 
Installation of DaqViewXL Software ……2 
Basic Function of DaqViewXL ……2 

Configuring an Acquisition ……3 
Data Header ……3 

Hints and Tips for DaqViewXL ……4 

To run a trial version of DaqViewXL, select 
“Authorization” from DaqView’s File Pull-down 
Menu, then click the 30 day trial button. 

Overview 
DaqViewXL is a Microsoft Excel add-in that provides complete setup and data acquisition within Excel 
under Windows 98, Me, NT, 2000, or XP.  Acquired data is immediately placed in an active spreadsheet, 
updating cells and graphics.  Data is then analyzed and graphically displayed.  DaqViewXL: 

• Augments Microsoft’s Excel spreadsheet software with data acquisition capability 

• Provides strip-chart graphics for real-time data display 

• Automatically converts data to engineering units 

Once DaqViewXL is installed within Excel, the spreadsheet provides a toolbar that contains all the data 
acquisition controls.  This DaqViewXL tool bar (also accessible from Excel’s menu) can enable all 
configuration and data acquisition tasks.  The features of Excel and DaqView are seamlessly combined to 
form a powerful data acquisition solution. 

DaqViewXL performs like DaqView despite a slightly different user-interface.  To set up your data 
acquisition system, you just click on the Configure button in the Excel tool bar.  DaqViewXL’s main 
window appears with all of the controls required to configure data acquisition including setting up input and 
output channels on an easy-to-use grid.  Each column of the channel-configuration grid corresponds to 
specific parameters in the data acquisition system and allows you to set these parameters on a per-channel 
basis. 

You can obtain automated reports by taking advantage of the Software Components concept.  For example, 
you can embed an Excel spreadsheet object into a Word document.  When the spreadsheet object is 
activated, it gives you access to DaqViewXL.  In this case, the Word document holds all text, as well as an 
embedded Excel spreadsheet object that holds raw and calculated data and graphics.  Double-clicking on 
the Excel object in Word can access DaqViewXL to efficiently prepare a statistical report.  This compound 
document allows you to collect, configure, analyze, graph, and annotate data with a few clicks of a mouse 
button. 

 

 

Program Requirements 
DaqViewXL requires the following software: 

• IOtech DaqBook/DaqBoard Series driver version 5 or later. 
Installed components must include DaqView version 7.7.25 or later. 

• Microsoft Excel 97 or later 
• Microsoft Windows Operating System (Windows 98, Me, NT, 2000, or XP) 
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Installation of DaqViewXL Software 
DaqViewXL is an option in DaqView that can be enabled by entering an appropriate authorization code 
into DaqView’s product registration dialog. DaqViewXL can also be enabled for a 30-day trial period by 
pressing the “Evaluation” button in the same dialog. 

The ability to run DaqViewXL can be verified by checking the option status in DaqView’s “About” dialog. 

To run DaqViewXL, simply start Excel and open the Daqviewxl.xls macro. You may be prompted about 
the workbook containing macros. This is OK. The DaqViewXL file uses Excel macros to communicate with 
DaqView. Click the “Enable macros” button to continue. 

To enable the DaqViewXL toolbar, click View-Toolbars-DaqViewXL. You can position this toolbar just 
like any other Excel toolbar. 

 

Basic Function of DaqViewXL 
DaqViewXL performs much like the standard DaqView.  With Excel’s macro capabilities, you can tailor 
DaqViewXL to meet various requirements.  Your knowledge of Excel will help you use all its tools for 
better data acquisition and processing.  The following sections give you the basics of how DaqViewXL can 
organize and analyze your data.  These basic ideas will give you the ability to explore all DaqViewXL has 
to offer.  The discussion mirrors previous sections and highlights the differences between DaqViewXL and 
DaqView.  The Hints and Tips section gives you tools and suggestions to improve your productivity with 
DaqViewXL. 

 

 

DaqViewXL Toolbar and Displays 
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Configuring an Acquisition 
To launch DaqViewXL’s main screen: 

1. If you have not already done so, install DaqViewXL. 
2. Enter Excel. 
3. Click the Configure... icon (the first one in the DaqViewXL toolbar). 

 
DaqViewXL Toolbar 

This launches DaqViewXL’s main screen (see following figure).  Note that DaqViewXL does not have a 
<View File Data> button, since data is viewed in the Excel spreadsheet. The earlier discussion of DaqView 
configuration still applies. 

 
DaqView Screen Within Excel 

Data Header 
DaqViewXL’s optional data header supplies the global acquisition parameters and the configuration of each 
channel and places this information directly in the spreadsheet along with acquired data.  This information 
includes channel gain or thermocouple type, bipolar/unipolar setting, units, and channel label.  To activate 
Data Headers select the Use Data Headers icon in the DaqViewXL toolbar. 

 
DaqViewXL Data Header 

Configure 

DaqViewXL Toolbar 

Jason:  Shouldn’t we 
identify the icons ? 
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Hints and Tips for using DaqViewXL 
 

• Do not run DaqView first and then try to use DaqViewXL.  When DaqViewXL runs, DaqView is put into a 
special "server" mode which supports transactions with "client" applications such as Excel.  Normally 
DaqView does not run in this mode and cannot support DaqViewXL. 

• When you acquire data into a worksheet, some of the data may be displayed as a string of hash marks 
(e.g. ######).  Excel will do this whenever the column is not wide enough to display all the digits of a 
number.  To  eliminate the hash marks, just widen the column.  An  easy way to do this is to use the 
"Format, Column, Auto Fit Selection" menu command.  Immediately after an acquisition, all the rows and 
columns of data are selected.  Click this menu item to automatically fit all the columns to the new data. 

• You can start an acquisition from an Excel macro as shown in the following VBA macro code example: 
Sub Macro1() 
   Application.Run Macro:="menuGoDoIt" 
End Sub 

This is equivalent to clicking the Go! button on the DaqViewXL toolbar.  It arms the hardware for an 
acquisition, and if DaqView is set up to trigger on "External TTL" or "Channel Value", the acquisition will 
take place automatically when the trigger condition is met.  For acquisitions configured to trigger on a "Key 
Hit", the acquisition will not start until the user presses the "Manual Trigger" button on the "DaqView 
Armed" dialog box. 

To automatically press this button after arming DaqView use the following macro: 
Sub ArmAndKeyHit() 
   Application.Run Macro:="menuGoDoIt" 'presses the Go! button 
   SendKeys "{ENTER}" 'presses the space bar 
End Sub 

This macro will start a "Key Hit" acquisition immediately. 

Note: Macro1, shown above, was generated by Excel's macro recorder. 

• If you chose to customize DaqViewXL’s toolbar, you should avoid removing buttons.  If DaqViewXL 
detects missing buttons it will prompt you to allow it to remove the toolbar and recreate it with all buttons.  
You can decline to do so, but DaqViewXL will continue to ask you to recreate the toolbar each time it 
starts-up.  You can add buttons, rearrange them, and re-size the toolbar without getting this prompt. 

• If DaqView cannot connect to your hardware on start-up, it will automatically switch to the Simulated 
Instrument mode when loaded from DaqViewXL. 
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